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Chapter 1. Introduction to Missing Values

Cases with missing values pose an important challenge, because typical modeling procedures simply
discard these cases from the analysis. When there are few missing values (very roughly, less than 5% of
the total number of cases) and those values can be considered to be missing at random; that is, whether a
value is missing does not depend upon other values, then the typical method of listwise deletion is
relatively "safe". The Missing Values option can help you to determine whether listwise deletion is
sufficient, and provides methods for handling missing values when it is not.

Missing Value Analysis versus Multiple Imputation procedures

The Missing Values option provides two sets of procedures for handling missing values:
v The Multiple Imputation procedures provide analysis of patterns of missing data, geared toward

eventual multiple imputation of missing values. That is, multiple versions of the dataset are produced,
each containing its own set of imputed values. When statistical analyses are performed, the parameter
estimates for all of the imputed datasets are pooled, providing estimates that are generally more
accurate than they would be with only one imputation.

v Missing Value Analysis provides a slightly different set of descriptive tools for analyzing missing data
(most particularly Little's MCAR test), and includes a variety of single imputation methods. Note that
multiple imputation is generally considered to be superior to single imputation.

Missing Values Tasks

You can get started with analysis of missing values by following these basic steps:
1. Examine missingness. Use Missing Value Analysis and Analyze Patterns to explore patterns of

missing values in your data and determine whether multiple imputation is necessary.
2. Impute missing values. Use Impute Missing Data Values to multiply impute missing values.
3. Analyze "complete" data. Use any procedure that supports multiple imputation data. See “Analyzing

Multiple Imputation Data” on page 17 for information on analyzing multiple imputation datasets and
a list of procedures which support these data.
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Chapter 2. Missing Value Analysis

The Missing Value Analysis procedure performs three primary functions:
v Describes the pattern of missing data. Where are the missing values located? How extensive are they?

Do pairs of variables tend to have values missing in multiple cases? Are data values extreme? Are
values missing randomly?

v Estimates means, standard deviations, covariances, and correlations for different missing value
methods: listwise, pairwise, regression, or EM (expectation-maximization). The pairwise method also
displays counts of pairwise complete cases.

v Fills in (imputes) missing values with estimated values using regression or EM methods; however,
multiple imputation is generally considered to provide more accurate results.

Missing value analysis helps address several concerns caused by incomplete data. If cases with missing
values are systematically different from cases without missing values, the results can be misleading. Also,
missing data may reduce the precision of calculated statistics because there is less information than
originally planned. Another concern is that the assumptions behind many statistical procedures are based
on complete cases, and missing values can complicate the theory required.

Example. In evaluating a treatment for leukemia, several variables are measured. However, not all
measurements are available for every patient. The patterns of missing data are displayed, tabulated, and
found to be random. An EM analysis is used to estimate the means, correlations, and covariances. It is
also used to determine that the data are missing completely at random. Missing values are then replaced
by imputed values and saved into a new data file for further analysis.

Statistics. Univariate statistics, including number of nonmissing values, mean, standard deviation,
number of missing values, and number of extreme values. Estimated means, covariance matrix, and
correlation matrix, using listwise, pairwise, EM, or regression methods. Little's MCAR test with EM
results. Summary of means by various methods. For groups defined by missing versus nonmissing
values: t tests. For all variables: missing value patterns displayed cases-by-variables.

Data Considerations

Data. Data can be categorical or quantitative (scale or continuous). However, you can estimate statistics
and impute missing data only for the quantitative variables. For each variable, missing values that are not
coded as system-missing must be defined as user-missing. For example, if a questionnaire item has the
response Don't know coded as 5 and you want to treat it as missing, the item should have 5 coded as a
user-missing value.

Frequency weights. Frequency (replication) weights are honored by this procedure. Cases with negative
or zero replication weight value are ignored. Noninteger weights are truncated.

Assumptions. Listwise, pairwise, and regression estimation depend on the assumption that the pattern of
missing values does not depend on the data values. (This condition is known as missing completely at
random, or MCAR.) Therefore, all methods (including the EM method) for estimation give consistent and
unbiased estimates of the correlations and covariances when the data are MCAR. Violation of the MCAR
assumption can lead to biased estimates produced by the listwise, pairwise, and regression methods. If
the data are not MCAR, you need to use EM estimation.

EM estimation depends on the assumption that the pattern of missing data is related to the observed data
only. (This condition is called missing at random, or MAR.) This assumption allows estimates to be
adjusted using available information. For example, in a study of education and income, the subjects with
low education may have more missing income values. In this case, the data are MAR, not MCAR. In
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other words, for MAR, the probability that income is recorded depends on the subject's level of
education. The probability may vary by education but not by income within that level of education. If the
probability that income is recorded also varies by the value of income within each level of education (for
example, people with high incomes don't report them), then the data are neither MCAR nor MAR. This is
not an uncommon situation, and, if it applies, none of the methods is appropriate.

Related procedures. Many procedures allow you to use listwise or pairwise estimation. Linear Regression
and Factor Analysis allow replacement of missing values by the mean values. In the Forecasting add-on
module, several methods are available to replace missing values in time series.

To Obtain Missing Value Analysis
1. From the menus choose:

Analyze > Missing Value Analysis...

2. Select at least one quantitative (scale) variable for estimating statistics and optionally imputing
missing values.

Optionally, you can:
v Select categorical variables (numeric or string) and enter a limit on the number of categories

(Maximum Categories).
v Click Patterns to tabulate patterns of missing data. See the topic “Displaying Patterns of Missing

Values” for more information.
v Click Descriptives to display descriptive statistics of missing values. See the topic “Displaying

Descriptive Statistics for Missing Values” on page 5 for more information.
v Select a method for estimating statistics (means, covariances, and correlations) and possibly imputing

missing values. See the topic “Estimating Statistics and Imputing Missing Values” on page 6 for more
information.

v If you select EM or Regression, click Variables to specify a subset to be used for the estimation. See the
topic “Predicted and Predictor Variables” on page 8 for more information.

v Select a case label variable. This variable is used to label cases in patterns tables that display individual
cases.

Displaying Patterns of Missing Values
You can choose to display various tables showing the patterns and extent of missing data. These tables
can help you identify:
v Where missing values are located
v Whether pairs of variables tend to have missing values in individual cases
v Whether data values are extreme

Display

Three types of tables are available for displaying patterns of missing data.

Tabulated cases. The missing value patterns in the analysis variables are tabulated, with frequencies
shown for each pattern. Use Sort variables by missing value pattern to specify whether counts and
variables are sorted by similarity of patterns. Use Omit patterns with less than n % of cases to eliminate
patterns that occur infrequently.

Cases with missing values. Each case with a missing or extreme value is tabulated for each analysis
variable. Use Sort variables by missing value pattern to specify whether counts and variables are sorted
by similarity of patterns.
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All cases. Each case is tabulated, and missing and extreme values are indicated for each variable. Cases
are listed in the order they appear in the data file, unless a variable is specified in Sort by.

In the tables that display individual cases, the following symbols are used:

+. Extremely high value

-. Extremely low value

S. System-missing value

A. First type of user-missing value

B. Second type of user-missing value

C. Third type of user-missing value

V



Percent mismatch. For each pair of variables, displays the percentage of cases in which one variable has a
missing value and the other variable has a nonmissing value. Each diagonal element in the table contains
the percentage of missing values for a single variable.

t tests with groups formed by indicator variables. The means of two groups are compared for each
quantitative variable, using Student's t statistic. The groups specify whether a variable is present or
missing. The t statistic, degrees of freedom, counts of missing and nonmissing values, and means of the
two groups are displayed. You can also display any two-tailed probabilities associated with the t statistic.
If your analysis results in more than one test, do not use these probabilities for significance testing. The
probabilities are appropriate only when a single test is calculated.

Crosstabulations of categorical and indicator variables. A table is displayed for each categorical variable.
For each category, the table shows the frequency and percentage of nonmissing values for the other
variables. The percentages of each type of missing value are also displayed.

Omit variables missing less than n % of cases. To reduce table size, you can omit statistics that are
computed for only a small number of cases.

To Display Descriptive Statistics
1. In the main Missing Value Analysis dialog box, select the variable(s) for which you want to display

missing value descriptive statistics.
2. Click Descriptives.
3. Choose the descriptive statistics that you want to display.

Estimating Statistics and Imputing Missing Values
You can choose to estimate means, standard deviations, covariances, and correlations using listwise
(complete cases only), pairwise, EM (expectation-maximization), and/or regression methods. You can also
choose to impute the missing values (estimate replacement values). Note that Multiple Imputation is
generally considered to be superior to single imputation for solving the problem of missing values.
Little's MCAR test is still useful for determining whether imputation is necessary.

Listwise Method

This method uses only complete cases. If any of the analysis variables have missing values, the case is
omitted from the computations.

Pairwise Method

This method looks at pairs of analysis variables and uses a case only if it has nonmissing values for both
of the variables. Frequencies, means, and standard deviations are computed separately for each pair.
Because other missing values in the case are ignored, correlations and covariances for two variables do
not depend on values missing in any other variables.

EM Method

This method assumes a distribution for the partially missing data and bases inferences on the likelihood
under that distribution. Each iteration consists of an E step and an M step. The E step finds the
conditional expectation of the "missing" data, given the observed values and current estimates of the
parameters. These expectations are then substituted for the "missing" data. In the M step, maximum
likelihood estimates of the parameters are computed as though the missing data had been filled in.
"Missing" is enclosed in quotation marks because the missing values are not being directly filled in.
Instead, functions of them are used in the log-likelihood.
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Roderick J. A. Little's chi-square statistic for testing whether values are missing completely at random
(MCAR) is printed as a footnote to the EM matrices. For this test, the null hypothesis is that the data are
missing completely at random, and the p value is significant at the 0.05 level. If the value is less than
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v Specify different percentages for suppressing cases displayed, for each of TTESTS, TABULATE, and
MISMATCH.

See the Command Syntax Reference for complete syntax information.
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Chapter 3. Multiple Imputation

The purpose of multiple imputation is to generate possible values for missing values, thus creating
several "complete" sets of data. Analytic procedures that work with multiple imputation datasets produce
output for each "complete" dataset, plus pooled output that estimates what the results would have been if
the original dataset had no missing values. These pooled results are generally more accurate than those
provided by single imputation methods.

Multiple Imputation Data Considerations

Analysis variables. The analysis variables can be:
v Nominal. A variable can be treated as nominal when its values represent categories with no intrinsic

ranking (for example, the department of the company in which an employee works). Examples of
nominal variables include region, postal code, and religious affiliation.

v Ordinal. A variable can be treated as ordinal when its values represent categories with some intrinsic
ranking (for example, levels of service satisfaction from highly dissatisfied to highly satisfied).
Examples of ordinal variables include attitude scores representing degree of satisfaction or confidence
and preference rating scores.

v Scale. A variable can be treated as scale (continuous) when its values represent ordered categories with
a meaningful metric, so that distance comparisons between values are appropriate. Examples of scale
variables include age in years and income in thousands of dollars.
The procedure assumes that the appropriate measurement level has been assigned to all variables;
however, you can temporarily change the measurement level for a variable by right-clicking the
variable in the source variable list and selecting a measurement level from the pop-up menu. To
permanently change the level of measurement for a variable,

An icon next to each variable in the variable list identifies the measurement level and data type:

Table 1. Measurement level icons

Numeric String Date Time

Scale (Continuous) n/a

Ordinal

Nominal

Frequency weights. Frequency (replication) weights are honored by this procedure. Cases with negative
or zero replication weight value are ignored. Noninteger weights are rounded to the nearest integer.

Analysis Weight. Analysis (regression or sampling) weights are incorporated in summaries of missing
values and in fitting imputation models. Cases with a negative or zero analysis weight are excluded.

Complex Samples. The Multiple Imputation procedure does not explicitly handle strata, clusters, or other
complex sampling structures, though it can accept final sampling weights in the form of the analysis
weight variable. Also note that Complex Sampling procedures currently do not automatically analyze
multiply imputed datasets. For a full list of procedures that support pooling, see “Analyzing Multiple
Imputation Data” on page 17.
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analysis variables to reveal or approximate a monotonic pattern. If no nonmonotone pattern exists after
reordering you can conclude that the data have a monotonic pattern when analysis variables are
ordered as such.

v Variables with the highest frequency of missing values. This displays a table of analysis variables
sorted by percent of missing values in decreasing order. The table includes descriptive statistics (mean
and standard deviation) for scale variables.
You can control the maximum number of variables to display and minimum percentage missing for a
variable to be included in the display. The set of variables that meet both criteria are displayed. For
example, setting the maximum number of variables to 50 and the minimum percentage missing to 25
requests that the table display up to 50 variables that have at least 25% missing values. If there are 60
analysis variables but only 15 have 25% or more missing values, the output includes only 15 variables.

Impute Missing Data Values
Impute Missing Data Values is used to generate multiple imputations. The complete datasets can be
analyzed with procedures that support multiple imputation datasets. See “Analyzing Multiple Imputation
Data” on page 17 for information on analyzing multiple imputation datasets and a list of procedures that
support these data.

Example.

Example.



Scan Data. Reads the data in the active dataset and assigns default measurement level to any fields with
a currently unknown measurement level. If the dataset is large, that may take some time.

Assign Manually. Opens a dialog that lists all fields with an unknown measurement level. You can use
this dialog to assign measurement level to those fields. You can also assign measurement level in Variable
View of the Data Editor.

Since measurement level is important for this procedure, you cannot access the dialog to run this
procedure until all fields have a defined measurement level.

Method
The Method tab specifies how missing values will be imputed, including the types of models used.
Categorical predictors are indicator (dummy) coded.

Imputation Method. The Automatic method scans the data and uses the monotone method if the data
show a monotone pattern of missing values; otherwise, fully conditional specification is used. If you are
certain of which method you want to use, you can specify it as a Custom method.
v Fully conditional specification. This is an iterative Markov chain Monte Carlo (MCMC) method that

can be used when the pattern of missing data is arbitrary (monotone or nonmonotone).
For each iteration and for each variable in the order specified in the variable list, the fully conditional
specification (FCS) method fits a univariate (single dependent variable) model using all other available
variables in the model as predictors, then imputes missing values for the variable being fit. The
method continues until the maximum number of iterations is reached, and the imputed values at the
maximum iteration are saved to the imputed dataset.
Maximum iterations. This specifies the number of iterations, or "steps", taken by the Markov chain
used by the FCS method. If the FCS method was chosen automatically, it uses the default number of 10
iterations. When you explicitly choose FCS, you can specify a custom number of iterations. You may
need to increase the number of iterations if the Markov chain hasn't converged. On the Output tab,
you can save FCS iteration history data and plot it to assess convergence.

v Monotone. This is a noniterative method that can be used only when the data have a monotone
pattern of missing values. A monotone pattern exists when you can order the variables such that, if a
variable has a nonmissing value, all preceding variables also have nonmissing values. When specifying
this as a Custom method, be sure to specify the variables in the list in an order that shows a monotone
pattern.
For each variable in the monotone order, the monotone method fits a univariate (single dependent



Singularity tolerance. Singular (or non-invertible) matrices have linearly dependent columns, which can
cause serious problems for the estimation algorithm. Even near-singular matrices can lead to poor results,
so the procedure will treat a matrix whose determinant is less than the tolerance as singular. Specify a
positive value.

Constraints
The Constraints tab allows you to restrict the role of a variable during imputation and restrict the range
of imputed values of a scale variable so that they are plausible. In addition, you can restrict the analysis
to variables with less than a maximum percentage of missing values.

Scan of Data for Variable Summary. Clicking Scan Data causes the list to show analysis variables and
the observed percent missing, minimum, and maximum for each. The summaries can be based on all
cases or limited to a scan of the first n cases, as specified in the Cases text box. Clicking Rescan Data
updates the distribution summaries.

Define Constraints
v Role. This allows you to customize the set of variables to be imputed and/or treated as predictors.

Typically, each analysis variable is considered as both a dependent and predictor in the imputation
model. The Role can be used to turn off imputation for variables that you want to Use as predictor
only or to exclude variables from being used as predictors (Impute only) and thereby make the
prediction model more compact. This is the only constraint that may be specified for categorical
variables, or for variables that are used as predictors only.

v Min and Max. These columns allow you to specify minimum and maximum allowable imputed
values for scale variables. If an imputed value falls outside this range,08 -1.2 TD
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that are within the specified ranges. If a set of values is not obtained within the specified number of
draws per case, the procedure draws another set of model parameters and repeats the case-drawing
process. An error occurs if a set of values within the ranges is not obtained within the specified number
of case and parameter draws.



From the menus choose:

Data > Split File...

1. Select Compare groups.
2. Select Imputation Number [Imputation_] as a variable to group cases on.

Alternatively, when you turn markings on (see below), the the file is split on Imputation Number
[Imputation_].

Distinguishing Imputed Values from Observed Values

You can distinguish imputed values from observed values by cell background color, the font, and bold
type (for imputed values). When you create a new dataset in the current session with Impute Missing
Values, markings are turned on by default. When you open a saved data file that includes imputations,
markings are turned off.

To turn markings on, from the Data Editor menus choose:

View > Mark Imputed Data...

Alternatively, you can turn on markings by clicking the imputation marking button at the right edge of
the edit bar in Data View of the Data Editor.

Moving Between Imputations
1. From the menus choose:

Edit > Go to Imputation...

2. Select the imputation (or Original data) from the drop-down list.

Alternatively, you can select the imputation from the drop-down list in the edit bar in Data View of the
Data Editor.

Relative case position is preserved when selecting imputations. For example, if there are 1000 cases in the
original dataset, case 1034, the 34th case in the first imputation, displays at the top of the grid. If you
select imputation 2 in the dropdown, case 2034, the 34th case in imputation 2, would display at the top of
the grid. If you select Original data in the dropdown, case 34 would display at the top of the grid.
Column position is also preserved when navigating between imputations, so that it is easy to compare
values between imputations.

Transforming and Editing Imputed Values

Sometimes you will need to perform transformations on imputed data. For example, you may want to
take the log of all values of a salary variable and save the result in a new variable. A value computed
using imputed data will be treated as imputed if it differs from the value computed using the original
data.

If you edit an imputed value in a cell of the Data Editor, that cell is still treated as imputed. It is not
recommended to edit imputed values in this way.

Analyzing Multiple Imputation Data
Many procedures support pooling of results from analysis of multiply imputed datasets. When
imputation markings are turned on, a special icon is displayed next to procedures that support pooling.
On the Descriptive Statistics submenu of the Analyze menu, for example, Frequencies, Descriptives,
Explore, and Crosstabs all support pooling, while Ratio, P-P Plots, and Q-Q Plots do not.
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v The Statistics table supports Means at Univariate pooling and N at Naïve pooling.
v The Correlations table supports Correlations and N at Naïve pooling.
v The Test table supports Mean at Univariate pooling.



v The Parameter Estimates table supports the coefficient, B, at Univariate pooling.

Discriminant Analysis. This procedure supports pooled model XML.
v The Group Statistics table supports Mean and Valid N at Naïve pooling.
v The Pooled Within-Groups Matrices table supports Correlations at Naïve pooling.
v The Canonical Discriminant Function Coefficients table supports Unstandardized Coefficients at Naïve

pooling.
v The Functions at Group Centroids table supports Unstandardized Coefficients at Naïve pooling.
v The Classification Function Coefficients table supports Coefficients at Naïve pooling.

Chi-Square Test. The following features are supported:
v The Descriptives table supports Mean and N at Naïve pooling.
v The Frequencies table supports Observed N at Naïve pooling.

Binomial Test. The following features are supported:
v The Descriptives table supports Means and N at Naïve pooling.
v The Test table supports N, Observed Proportion, and Test Proportion at Naïve pooling.

Runs Test. The following features are supported:
v The Descriptives table supports Means and N at Naïve pooling.

One-Sample Kolmogorov-Smirnov Test. The following features are supported:
v The Descriptives table supports Means and N at Naïve pooling.

Two-Independent-Samples Tests. The following features are supported:
v



Analysis Output. This group controls the type of Viewer output produced whenever a multiply imputed
dataset is analyzed. By default, output will be produced for the original (pre-imputation) dataset and for
each of the imputed datasets. In addition, for those procedures that support pooling of imputed data,
final pooled results will be generated. When univariate pooling is performed, pooling diagnostics will
also display. However, you can suppress any output you do not want to see.

To Set Multiple Imputation Options

From the menus, choose:

Edit > Options

Click the Multiple Imputation tab.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,



Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group
ATTN: Licensing
200 W. Madison St.
Chicago, IL; 60606
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:

© your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs.

© Copyright IBM Corp. _enter the year or years_. All rights reserved.
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Trademarks

IBM,theIBMlogo,andibm.comaretrademarksorregisteredtrademarksofInternationalBusiness

MachinesCorp.,registeredinmanyjurisdictionsworldwide.Otherproductandservicenamesmightbe

trademarksofIBMorothercompanies.AcurrentlistofIBMtrademarksisavailableontheWebat

“Copyrightandtrademarkinformation”atwww.ibm.com/legal/copytrade.shtml.

Adobe,theAdobelogo,PostScript,andthePostScriptlogoareeitherregisteredtrademarksortrademarks

ofAdobeSystemsIncorporatedintheUnitedStates,and/orothercountries.

Intel,Intellogo,IntelInside,IntelInsidelogo,IntelCentrino,IntelCentrinologo,Celeron,IntelXeon,

IntelSpeedStep,Itanium,andPentiumaretrademarksorregisteredtrademarksofIntelCorporationorits

subsidiariesintheUnitedStatesandothercountries.

LinuxisaregisteredtrademarkofLinusTorvaldsintheUnitedStates,othercountries,orboth.

Microsoft,Windows,WindowsNT,andtheWindowslogoaretrademarksofMicrosoftCorporationinthe

UnitedStates,othercountries,orboth.

UNIXisaregisteredtrademarkofTheOpenGroupintheUnitedStatesandothercountries.

JavaandallJava-basedtrademarksandlogosaretrademarksorregisteredtrademarksofOracleand/or

itsaffiliates.
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